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You will also find detailed information about how to use MARC Magician Professional in the Help section of the
program, by selecting Help from the menu and then Help Topics.

This tutorial requires a basic knowledge of how to use Windows and Windows based products, including
opening and closing windows, minimizing and maximizing windows, and using menus and search boxes.
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This booklet has instructions for installing and starting MARC Magician Professional as well as a brief
overview of its functions. It assumes a basic knowledge of Windows and Windows-based functions, including
opening and closing programs, minimizing and maximizing windows and the use of menus and search bhoxes.

You will also find detailed information about how to use MARC Magician Professional in the Help section of the
program, by selecting Help from the menu and then Help Topics.
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What is MARC Magician Professional?

Powerful tools make a powerful impact on your work and Mitinet's MARC Magician™ is the
most powerful tool on the market today for MARC record creation and maintenance.

NOTE: See the MARC Magician Professional Help Topics for detailed information
about the program, including import and export instructions and a Cataloger's
Reference Guide. You can also look at the Tutorials in the Support section of our
web site, Www.mitinet.com, for step-by-step examples.

Here are just some of the benefits of MARC Magician:
Edit your data faster

e Fix inconsistencies in your call numbers
® Use built in MARC codes & rules to catalog or fix records, such as AACR2

e Set up the fields you want to edit in a few steps with our Global Editing, and let MARC Magician
do the rest

e Maximize the value and discoverability of your library's materials
Find & Fix Errors Easier

* Use our customizable Active Error Checking to find missing information, punctuation and
non-filing indicators and other common errors.

e Record errors are clearly flagged and MARC Magician even points out the error type,
saving you time in corrections
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Features
Global editing

A fast and powerful way to clean up MARC records, MARC Magician Professional provides global
editing commands for:

* Checking spelling (American, British, French, and Spanish dictionaries)

* Finding and replacing text

e Changing the material type (for example, changing books to videos)

e Deleting fields and subfields

® Converting uppercase fields to correct capitalization

Active Error Checking

Active Error Checking™ helps you spot potential problems with your records by flagging records
that don't meet certain criteria and showing you what you need to do to fix them. Use the program
options to define the types of mistakes and omissions that should be considered errors.

Easy cataloging
* Create quality MARC records without learning complicated MARC rules.

¢ Information panels provide real-life examples, cataloging tips, and AACR2 rule numbers
for most subfields. The Active Error Checking panel lets you know if the record you create
meets the cataloging standards you specify.

e Spellcheck your records using American, British, French, and Spanish dictionaries.

¢ Set non-filing indicators and insert the correct ISBD punctuation, automatically.

* Standard templates cover every type of library material you catalog. Add often-used fields
to all standard templates at once or create your own custom templates.

e The Cataloger's Reference (found in the Help Topics) provides in-depth information and
examples for most MARC fields and subfields.

Other features

e The MARC Magician Professional Help Topics contain detailed program information in
an organized, easy-to-use format. Topics include specific instructions on importing and
exporting your records, and a Cataloger's Reference with detailed cataloging information.

* The Record Viewer lets you browse through a large number of records quickly.

e Easily check your records before exporting or printing them.

e Automatic record repair automatically checks imported records for structural accuracy
and corrects ISBD punctuation, non-filing indicators, GMD, invalid indicators, and invalid
control fields.
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Installing & Starting the Program

The Startup Wizard helps you to choose some of the options that you need when you work with
MARC Magician Professional. To use the Startup Wizard (Magician rolling out a red carpet) enter
the access key you received in your introductory email. Follow the Startup Wizard instructions
on your screen.

To start MARC Magician, double-click the icon on your desktop.

Using MARC Magician Professional to Create, Edit,
and Organize Records

MARC Magician Professional has four essential parts: the Main Window, Cataloger, Record Viewer,
and the Help system.

The Main Window

The Main Window is present whenever the program is running and it's where you begin and
end all of your tasks in MARC Magician Professional. When you close the Main Window, you
exit the program.

Like most Windows programs, MARC Magician Professional has a row of menus (File, Edit, View,
etc.) and a toolbar with buttons for commonly used commands. The status bar appears at the very
bottom of the Main Window and shows how many records you have and how they are sorted.

Sections of the Main Window
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Lists

Lists occupy most of the Main Window. A list is a group of records, organized in rows and columns.
Each record takes up one row, and each column shows a particular aspect of the record, such as the
author or title. Each list is a separate window inside the Main Window. These windows can be
resized but they can't be closed, so the close button is dimmed.

MARC Magician Professional always has at least two lists: the Master List and the Weeding Truck.
The Master List is the complete list of records in the MARC Magician Professional database. The
Weeding Truck is like the Recycle Bin: when you delete records from the Master List, they go into the
Weeding Truck.

To switch between lists, open the List menu (or the Window menu) and click the list you want.

The Cataloger
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Cataloger is where you create and edit MARC records. Double click on a record in the Master List to
open it in Cataloger. In Cataloger you can have a maximum of 10 pages open at a time.

Like the Main Window, Cataloger has menus, a toolbar, and a status bar. The record you've opened
will be displayed in a separate window inside Cataloger.

The buttons with the numbers and letters on the left side of the window are the MARC field tags and
subfield codes. Click these to display a menu of the commands available for that field or subfield.
When you put the insertion point (cursor) in an empty field, MARC Magician Professional displays a
prompt that tells you what information is needed.
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The boxes that appear alongside the record window are information panels. The text in most
panels changes when you move the cursor (or insertion point) to a different subfield. If you don't
need a panel, close it by clicking the close button in the top right or left corner of the panel.

To reopen a panel, click the View menu and then select the panel you want to display. When you
close the Cataloger, you return to the Main Window.

For a step-by-step cataloging exercise, see Cataloging Basics, in the tutorial section of this manual.
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Use Record Viewer to check your records. In Record Viewer, you can quickly page from one record
to the next, and maintain an unlimited number of open records. To open Record Viewer, select the
records you want to view in the Master List, and then click Record Viewer on the toolbar.

While working in Record Viewer, you can print records, open a record in Cataloger for editing, and
export records. For a step-by-step Record Viewer exercise, see Working with the Record Viewer, in the
tutorial section of this manual.
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The Help system %]

The Help system contains thorough and up-to-date information about how to use MARC

Magician Professional, displayed directly on your computer screen. It has complete instructions for
working with the program as well as general cataloging advice and detailed explanations of MARC
fields and subfields.

There are three basic parts to Help:

e General help topics: Including overviews, step-by-step instructions, and a glossary of
technical and cataloging terms. Find topics using the table of contents, the index, or a
full-text search. To get to general help topics, click the Help button on the toolbar, or
press the F1 key on your keyboard.

* Dialog box help: Most dialog boxes have a Help button in the lower right corner. With the
dialog box open, click the Help button or press the F1 key for an explanation on how to use
the dialog box.

e Cataloger's Reference: Gives general cataloging advice and details about most MARC fields,
including examples and information about subfields and indicators. To open the Cataloger's
Reference topic for a specific field, click the tag of that field and then click the Help button.

Bringing records into MARC Magician Professional

Before you can clean up or customize existing records using MARC Magician Professional, you have
to import them into MARC Magician Professional. Imported records are added to the Master List
along with the records already there. Once you have imported them, you can work with them in

all the same ways that you work with records you create.

How you transfer records depends on where the records are located:

¢ In your library automation system database: These are records in your library
automation system that haven't been exported yet. Bringing these records into MARC
Magician Professional is a two step process: First, export a copy of the records from your
library automation system (see your library automation system documentation or the MARC
Magician Professional Help), then you import them using the Import command on the MARC
Magician Professional File menu.

¢ In a file on your computer:. These are records downloaded from the Internet (such as the
Library of Congress or a state database), or already exported from your library automation
system and saved on the hard disk of your computer or another computer on the same
network. To bring these records into MARC Magician Professional, use the Import command
on the File menu.

¢ On a CD or thumbdrive: These may be records from a vendor or already exported from your
library automation system and saved on a CD or thumbdrive. To import these records, use
the Import command on the File menu.

¢ In Mandarin: Use the EZ Transfer feature built into both MARC Magician Professional and
Mandarin to transfer your records. It's a two-step process, with EZ Transfer to get records
out of Mandarin and EZ Retrieve to bring them in to MARC Magician. You'll find complete
instructions in the Help Topics.
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Editing Individual Records Using Cataloger

In Cataloger, you can edit subfield text using your keyboard as you would in a word processing
program. You can also add, delete, and change fields and subfields.

To... Do this...
Add a field E Click the Add Field button on the toolbar, and then select the field you want.

Add a subfield Put the insertion point anywhere in the field where you want the new subfield.
E Click the Add Subfield button on the toolbar and then select the subfield you want to add.

Delete a field Put the insertion point anywhere in the field you want to delete, and then click the
ﬂ Delete Field button on the toolbar.

Delete a subfield | Put the insertion point in the subfield you want to delete, and then click the
ﬂ Delete Subfield button on the toolbar.

Duplicate a field | Click the field tag or subfield code, and then click Duplicate.
or subfield

Change a field or | Click the field tag or subfield code, and then click Change. Select the field or subfield you
subfield want to change to.

For a step-by-step cataloging exercise, see Editing Records, in the Tutorial section of this manual.
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Editing Several Records at a Time (Global Editing) ﬂ

MARC Magician Professional provides several commands to make global changes to your records,
including adding a field, finding and replacing text, fixing capitalization, and much more. This
document only provides a very basic outline of the global editing procedure. For more detailed
information, see MARC Magician Professional Help.

Basic procedure for global editing

1. Select the records you want to work on (see table below).

To...
Select a single record

Select all records in the list

Select a block of consecutive
records

Select muItip_Ie
nonconsecutive records

Select records that fulfill
certain criteria

Deselect all records

Deselect a single record

2. Select Global Editing from the toolbar, and then the
command you want. (The example shows a Find &

your Subject Headings.)

3. Enter the information about the change you want to

make, and then click OK.

The Make Change dialog box appears for each

Do this...
Click the record

On the Select meny, click All Records.

Click the first record in the block, and then press the Shift key and hold it
down. Click the last record in the block, and then release the Shift key.

Press the Ctrl key and hold it down. One by one, click each record you
want to select, and then release the Ctrl key.

On the Select menu, click the command you want. In some cases a dialog
box will appear, prompting for more information. Previous selections will
be removed.

Click somewhere else in the list. The record you click on will be selected,
but all other records that were previously selected will no longer be
selected.

Press the Ctrl key and hold it down. Click the record you want to deselect,
and then release the Ctrl key.

potential change. This allows you to see how each
record will change before it's actually made. You should
always review at least the first few changes. Once you're
satisfied with the way the command is working, click
Change All to make the change in all of the selected
records, without further prompting.

For step-by-step Global Editing exercises, see Global
Editing Basics, and Advanced Global Editing, in the
tutorial section of this manual.

x|
 Fields to loak in
. . Al
Replace command to remove Juvenile Literature from & Selected Clea Seected |
- [ Physical description ;I
[ [ Mates
Fﬂ [+ Subjects J
rfj [ Murmbers and codes
&[] Added entri
.1 ‘:nvifr e LI
Figlds to search: |
Examples:  100a, 245, 500-5339, 610
1-999
o, 003
— Test to find and replace
Find what: | Juvenile literature
[ Match case v Wwhole words only
Replace with: l
“Waming: You can't "Unde" ta
cancel changes made here.
¥ Frompt me far each change Cancel I Help |
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Important Note: Global editing is powerful. It's possible to fix a lot of errors in a very short
time — but you can also do a lot of damage. It's good to develop a habit of making a backup of
your records before you do any global editing task. To do this, click on the File menu and then
Backup Database. With a backup, if you do make a mistake, you can easily restore the database
to its previous condition by clicking File and then clicking Restore Database.

Remember that you are editing records in MARC Magician Professional, not in your library
automation system's database. Changes made to records won't reflect in your library system's
database until you transfer them back into your library system.

Creating Original MARC Records

Every record in MARC Magician Professional is based on a template that corresponds to the
type of material (book, videocassette, etc.).

To create a new record:
From the Record menu, click New Record. The Select Template dialog box appears.
Select the template you want, and then click OK.

The Cataloger opens, displaying a blank record. The buttons with the numbers and
letters on the left side of the window are the MARC field tags and subfield codes.

The blinking vertical line is the cursor, or insertion point, showing where the characters
you type appear on the screen. Next to that is the cataloging prompt, which tells you
what information belongs in the current subfield.

Enter the main entry, (title, publication information, etc.) in the appropriate fields and
subfields.

Enter holdings information (call number, bar code, location, price, etc.) as follows:

If you use Easy Entry holdings, select Holdings EI from the toolbar to enter holdings
information.

If you use Custom holdings, the holdings field (usually 852) appears in the record
window along with the rest of the fields. Enter the holdings information as you would
in any other field.

Save the record by clicking the Save button on the toolbar.

To close the record, click the close button in the upper right corner of the record window.
Unless you want to catalog another item, it's usually a good idea to close the Cataloger and
return to the Main Window.
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Transferring Records from MARC Magician Professional to
Your Library Automation System

When you're finished creating original records or cleaning up existing records with MARC Magician
Professional, you'll need to export and then import them into your library automation system.

For Mandarin

If you use Mandarin, use the two-step EZ Transfer feature built into MARC Magician Professional
and Mandarin to transfer your records to your library system. EZ Transfer gets records out of MARC
Magician Professional and EZ Retrieve to bring them into Mandarin. There are step-by-step
instructions on the EZ Transfer process in the Help Topics.

Exporting Records for other library systems
Select the records you want to export.
Under File, select Export Records.

If any of the records you selected contain export errors, a dialog box will appear, asking
whether you want to export all records or only those without export errors. After you
make your choice and click OK, the Export dialog box appears.

Specify a file name and location for the records, and then click OK.

A copy of the records is then saved to a file, which you can now import into your library
automation system. The records also remain in MARC Magician Professional.

You can delete them from the MARC Magician Professional database if you are
finished with them.

Import the file into your library automation system.
For detailed instructions, see the documentation that came with your system.

The MARC Magician Professional Help also contains import instructions for many
systems.
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MARC Magician Tutorials

Here's a brief overview of the tutorials:

Cataloging Basics

Create new records.
Enter cataloging information in fields and subfields.
Enter holdings information.

Editing Records

Add, delete, and change fields and subfields.
Check spelling.

Building Your Own Templates
Create a new custom template

Working with Lists

Sort and select records.
Find specific records in the list.
Create your own record lists.

Working with the Record Viewer

Open, Browse, and Print your records.

Finding Potential Problems — Active Error Checking

Set Active Error Checking options and see how to monitor your records.

Global Editing Basics

Find and replace text in a group of records.
Add a field to a group of records.
Fix the capitalization of fields or subfields that are all in upper case.

Advanced Global Editing

Globally change a field.
Use the “get text"” feature to copy text from another part of the record.
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Using These Tutorials

These tutorials will give you a basic understanding of the features and functions of MARC Magician.
Some of the tutorials require you to import sample records to work on, and it's recommended that
you always delete the sample records when you're done with the tutorial.

Using the tutorials also requires a basic knowledge of how to use Windows and Windows based
products, including opening, minimizing, maximizing and closing windows, and using menus, search
and dialog boxes.

The tutorials don't need to be completed in any particular order, but some of the exercises do flow
logically from one to the next. At the end of each section, we'll give you suggestions for exercises
you can do to practice that tutorial's topic further.

Good luck and have fun.

Moving From the Tutorials to Working on Your Own Records

Once you've completed any tutorial and you want to get to work on your own records, you'll need to
delete any practice records you've made:

1. Click Select, and then click All Records.
2. Click Record, and then click Delete from All Lists. The Master List should now be empty.
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Section 2 - Cataloging Basics

Today, you have a wide variety of places to find MARC records, including MARC on Demand.., vendor
disks, union catalogs, and the Internet. But there will always be some materials with no MARC
record at all.

To follow the exercises in this tutorial, first imagine you find a grimy old box outside your office door
one morning. Gingerly, you open it. It's full of books — weird and wonderful books you've never heard
of before. One catches your eye, a book of poetry titled The Wee Book of Muskrats, by Amanda
Reckonwith, published in 1931 by the now defunct Pennypouch Press in Little Rock, Arkansas.

Today, you will rescue this little book from eternal obscurity by adding it to your catalog.

In this tutorial you'll learn how to:
* Create new records.
* Enter cataloging information in fields and subfields.
* Type special characters.
e Enter holdings information.
e Save records.

Creating new records

Every record in MARC Magician is based on a template that corresponds to the type of material
(book, DVD, etc.). The template guides you as you catalog, because it contains the fields and
subfields you are most likely to use for each type of material. MARC Magician comes with
standard templates that cover the different kinds of materials you catalog.

Create a new record for a book e
1. Select New Record from the toolbar. L

For books, deciding on a template is easy. There is only one standard
template for regular books, with the exception of atlases and songbooks.

2. Click Book (not atlas or songbook), and then OK.
The Cataloger opens, displaying a blank record:
The buttons with the numbers and letters on the left

[ Mised mateisl [rot ki) |

0K | cacd | He |

Eile Edit View Record Field Subfield Template Window Help

7ol@| o] | Em e e |elc|x|y] e 1] &l 2] side of the window are the MARC field tags and

subfield codes.

010 | [a] 100 Main Entry ~ Personal Name)

I8 o ) B The blinking vertical line that appears next to 100 a
_n_q e is the inser’gion point or cursqr._Next to t_he cursor is
E e, the catal_oglng prompt, describing what information
i = belongs in the current subfield.
L - = = [ The Tips and Examples panels help if you're unsure
el e about the purpose of a subfield or the correct form of
M’ﬁ’m““ M‘?‘j’:’:’h“ﬁﬂfvﬂww SsSsssses)  entry. The information changes every time you move
ForHelp, press F1 [omplate: Baok (uot s or songbock) [MatsslypeBockotatasor ;| LO @ different subfield.
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You may find it helpful to maximize Record Window to see more of the record on your screen. You
can also maximize Cataloger window to fill your whole screen. To move the cursor to different
subfields, either press Enter or Tab to move down one subfield. The arrow keys can be used to move
up and down. Notice that the cataloging prompt changes as you move from one subfield to the next,
as does the text in the information panels.

Entering descriptive information

Now that you've opened a template for a new record, the next step is to fill in the blank fields and
subfields with information describing the book.

Enter main entry information

The first piece of information to add is the main entry, the primary entry that represents an itemin a
catalog. Each record should have exactly one main entry.

For books authored by a person, the main entry is the author's name. The main entry goes in
100 (Main Entry: Personal Name), the first field in this record.

1. Move the cursor to subfield 100 a, enter Reckonwith, Amanda and then press Enter to move to
the next subfield. The cataloging prompt disappears as soon as you begin to type.

Subfield d is for the author's birth and death dates and distinguishes between two or more
authors with the same name. Skip this subfield. Even if you had more than one Amanda
Reckonwith in your catalog, you don't have the dates of her birth or death.

2. Press Enter to skip subfield d and move on to the next field.

Enter title information

The 245 (Title Statement) field is where the title proper, other title information, and the statement of
responsibility is entered. For most books, our example included, this information is on the title page.

1. In subfield a, type The wee book of muskrats and then press Enter. Note the capitalization —
only the first word and proper names in titles should be capitalized.

2. Subfield b is for other title information such as a subtitle or parallel title. No subtitle appears
on the title page, so skip this subfield. Press Enter to move to subfield c.

3. Subfield c is for the statement(s) of responsibility. The title page of our book shows two:
Amanda Reckonwith, the author, and James DuPré¢, the illustrator. Enter by Amanda
Reckonwith ; illustrations by James DuPré

Note: To type in special characters, like the accent in EE mrr;'r::r;r;'r-rrrrr-
8 cli i FERERECCTICCT
DuPre click the Special Character-s button on the toolbar. ‘ : I e e S
Select the character you want to insert from the table of special ]EII%'IEFIE_IIE%[E%[FFFF rl:
: i L} i il
f:haracte[s. Make sure your cursor is where you want the character e R T RS S
inserted into the record. Press Enter to move to the next subfield. rFrFrrFFErrorErrorr
. ) ) ) EREREEEFEFREEEE
Notice the gray punctuation marks following your entries. F F:’{EFF}EE{E{EI@FE IE
- H HN 5 A £ (4 1L |¢ [# oo lE |0 [
This is Internatlt_)nal Standard B_|b_||ograph|c Description T e i
(ISBD) punctuation. MARC Magician automatically adds the e el el el el e el el e el e
correct ISBD punctuation (., /: +) as needed. i
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Enter edition information
The 250 (Edition Statement) field is for the edition information that appears on the title page.
In subfield a, type 2nd ed. and press Enter.

Enter publisher information (imprint)

The 260 (Publication, Distribution, Etc.) field is for information about the publisher and the date of
publication.

1. In subfield a, type Little Rock, Ark. and press Enter. Remember to type the period after the
state abbreviation!

2. In subfield b, type Pennypouch Press and press Enter.
3. In subfield c, type 1931 and press Enter.

Enter the physical description
The 300 (Physical Description) field is for the physical description of the item.

1. The first subfield in this field is for the extent. For books, that means the number of pages.
In subfield a, type 75 pages and press Enter.

2. Subfield b is for other physical details. In subfield b, ﬂ'jlﬁsck°nwi‘h~‘\ma"da-
type illustration and press Enter. 12451 18] The wee book of muskrats /
3. Subfield c is for the dimensions of the book. In subfield ﬂby Amanda Reckomith : lstrations by James DUPré
c, type 24 cm and press Enter. 1250] Ja] 2nd ed.
L1260} 8] Little Rock, Ark :
So far, your record should look something like this. ﬂ Pennypouch Press ,
£f1931 .
- ) [300| al75p :
TIP: Look at the Tips and Examples panels for sl ;
guidance_in the correct style, capitalization, and ﬂlj' 2em.
punctuation. l
850 af
B

Entering subject headings

Now that you've completed the descriptive part of the record, it's time to create some subject
headings. Because many library patrons search for material according to subjects, subject
headings are among the most important parts of a MARC record.

As you can see on your screen, the template includes a number of 650 (Subject Added Entry -
Topical Term) fields. A topical subject heading is just that: topical.

In other words, this is the place for general terms that describe what the book is about.
So what is this book about? It's a book of poetry about muskrats.
1. Subfield a is for a topical term. Type Muskrats and press Enter.

2. The next subfield is x (General subdivision). For this heading, a general subdivision is not
needed, but suppose you want to enter a subdivision for the genre of the book — namely,
poetry.Technically speaking, this information belongs in the v (Form subdivision) subfield.
For now, you'll deliberately enter the genre in the wrong subfield. You'll fix this in the next
tutorial. In 650 x, type Poetry.
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Entering holdings data

Holdings data includes copy information and other information needed for local processing and
maintenance of library materials. Some examples are bar code, call number, location, and price.

Part of the initial MARC Magician program setup during installation involved choosing a holdings
type. This setting ensures that the holdings data you enter using MARC Magician are compatible
with your library automation system and consistent with the existing records in your catalog.

Check your holdings type e
Before you enter holdings information, you need Catalogng | View | Active Enox Checking | Speling | Templote | Import| Card | Label | Advanced]
to know whether the holdings type in MARC  Hokdings
Magician is set to easy entry or custom. © Empenty  [Folet Caaog Pl 41 =l
1. Click the Options button on the toolbar. S st
Mext bar code:
In the Options dialog box, Under Holdings, either o |

Easy Entry or Custom will be selected.
If Easy Entry is selected, you'll see an additional
setting that shows:

your library automation system,

852 with 1 part call number, or

852 with 4 part call number.

If Custom is selected, the MARC fields and subfields to be used for holdings are displayed under
Current Settings.

2. Make a note of your holdings settings and click OK to close the Options dialog box.

Using Easy Entry holdings H

If you use Easy Entry holdings, you enter holdings

information in a special dialog box that contains the same -1

holdings fields as your library automation system. e B R

Select Holdings from the toolbar.  — B e m—
) ) ) Calnumber [F534TER 2 P —

This example shows the Holdings dialog box for one Desrt et e [

. . . e[ B N e —

library automation system. If you use a different system, e[ [ e

the dialog box you see on your screen will look slightly dif- = - M’i

.. . Coyrumben [T

ferent, but the basic idea is the same. e I —

You'll see different fields in the Holdings dialog box on

your screen, depending on the holdings type you selected. o

Try moving the cursor to different fields and note that the | |

help text at the bottom of the dialog box changes as you e | o | [ P

move from one field to the next.

Practice entering holdings information now if you like.

Mitinet Library Services - Getting Started with MARC Magician Professional 18



Note: You can't use the Enter key to move from one field to another in the Holdings dialog
box. Pressing Enter is the equivalent of clicking OK - it closes the dialog box and accepts any
changes you've made.

Here's a brief explanation of the buttons at the bottom of the dialog box:

Use the New and Duplicate buttons to add holdings information for another copy of the book.
Each time you add a copy, a new tab is added to the dialog box. The tabs are labeled #1, #2, etc.
Click on a different tab to switch to it.

The New button creates all blank fields on the tab. The Duplicate button fills the new tab with the
same information as the current tab, except the bar code. You can enter holdings information for

up to 99 copies.

As in all dialog boxes in the program, OK saves your entries and closes the dialog box, Cancel
closes the box without saving any changes, and Help displays a help topic about the box.

Click OK to close and save your changes.

Since you use Easy Entry holdings, you can skip the Custom Holdings section and go to the next
exercise, Checking Control Fields.

Using Custom Holdings

If you use Custom Holdings, the holdings fields and subfields defined in Options have been added
to the cataloging templates, and should appear in the Record Window along with the bibliographic
fields.

Type information in this field just as you would in any other field. With Custom Holdings, MARC
Magician doesn't know what information belongs in each subfield - you have to keep track of that
yourself. It's a good idea to make a list of the fields and subfields you use for holdings and refer to
it when you catalog.

Saving your record

Now that you have completed your record, save it by clicking the Save button on the toolbar.

Tip: Another way to save your record is simply to close the Cataloger. If your record has
unsaved changes, the program will ask you whether you want to save the record, including
the latest changes.

Close the Cataloger
When you are finished cataloging, close the Cataloger and return to the main window.

Under File, click Exit, or click the close button in the top right corner of the Cataloger window.
You return to the main program window. Notice that the record you created now appears in the
Master List.
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Review & Practice

Some suggestions for practicing on your own
Create some more records. Try using some of the other cataloging templates.
For example, try cataloging a sound recording or a videocassette.

Notice the different fields and subfields in other templates. Take the time to read the
Examples and Tips panels for unfamiliar subfields.

Go to the next tutorial
Section 3 - Editing Records has more cataloging exercises for the record you created in this tutorial.

If you'd like to jump right in to the next tutorial, stay where you are in the main window. You're all set
to begin the next tutorial. Remember that you can do most of the tutorials in any order you'd like.
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Section 3 - Editing Records

To complete the exercises in this tutorial, you'll need to have completed Section 2, the basics of
creating new MARC records, as those records are used as examples for this tutorial.

In this tutorial you'll learn how to:
¢ Add, delete, and change fields and subfields.
¢ Add fields to all standard templates.
* Reverse your last action with Undo.
* Display detailed information about specific fields.
¢ Check spelling.
¢ Add words to your user dictionary.

Open a record

The first thing you should do is open the record you created in the first tutorial -
The wee book of muskrats.

There are several ways to open a record. You can:
* Double-click the record.
¢ Click the record once to select it, and then click the Edit button |‘5%| on the toolbar.
* Click the record once to select it, and then press Enter.

The record is now open in Cataloger.

Adding fields and subfields

As you learned in the first tutorial, the template determines which fields and subfields are displayed
by default in the Cataloger. But what if the template doesn't include a field you want to use?

In this exercise, you'll learn how to add fields by adding a summary note to your record.

Add a field F |
1. Click Add Field on the toolbar. %
Check the fekds 1o add
2. Under Check the fields to add, select the 520 (Note: Summary) @ Fowerchoices © blow choicss
check box, or type 520 in the box underneath. %E:“g’m’“&;‘omjﬁﬁm o 4
- :lSJ (Series Statement ’
3. Click OK to add the field. S |
4. In 520 a, type 50 short poems about ﬁi e
muskrats. B[ E[75p. 6 Note Longuoge] =
g il & in a field tag
El24 cm. 1 ‘
1520 J5] 50 short poems about muskrats .
690 af Muskrc:ttsp : = 0K | coced |  Heb |
| Poetry .

cand sl
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Add a subfield

You use a similar procedure to add subfields to your record. Although you won't add a subfield in
this tutorial, here's how you would do it:

1. Put the cursor in the field where you want to add a subfield. 5+
2. Click the Add Subfield button on the toolbar.
3. Inthe Add Subfields dialog box, select the subfield you want, and then click OK.

The subfield you selected is added to the field directly after the subfield that had the cursor.
If you want to move the subfield to a different location within the field, drag the subfield
code with your mouse.

Adding fields to all standard templates

In the last exercise you learned how to add a field to a single record. Now suppose you want to use
this field in all of the records you create. In MARC Magician, you have the option to add fields to all
standard templates, so that you don't have to add them every time you create a new record.

In this exercise, you'll add an International Standard Book Number (ISBN) field to all standard
templates.

1. Under Template, click Add Fields to Standard Templates. The Options dialog box appears with
the Template tab in front:

2. Select the International Standard Book Number (020) check box, and then click OK.

Catalogng | View | Active Ewor Checking | Speling Template | import | Card | Label | Advanced |
Check the fields pou want to appear in all standard templates:
I Libraey of Congress Conirol Number (010)
Note: Add as many fields as you like. If the field you (AT ) e e
want isn't in the dialog box, use the More Fields button [ ek St T T sttty St
to select from the full list of MARC fields. e
Also: Notice that the ISBN field you just added doesn't e i
appear in The Wee Book of Muskrats. That's because e s o et |
records that are currently open in the Cataloger aren't Nt i3
updated right away. If you closed the record and then ——— :ﬂﬂmw"m E
opened it again, you would see the ISBN field.
» [ )

Create a new record |
Let's see if the field shows up when you create a new record:
1. Click the New Record button on the toolbar.

2. In the Select Template dialog box, choose the Book (not atlas or songbook) template, and then
click OK. The 020 (ISBN) field should now be the first field in the record.

3. Close the record without saving it.
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Deleting fields and subfields

You can remove a field or subfield from your record in a couple of different ways. One way is to
delete all of the text in the field or subfield. When you do this, you still see the blank field or
subfield in the record window, but it does not become a part of the MARC record.

Note: Empty fields and subfields are never saved with the record when you export it from
MARC Magician - so there is no need to remove them from your records.

Delete a subfield

A quick way to remove a subfield is to click directly on the subfield

you want to remove. Let's try it.

Click the 300 c subfield code button. Click the Delete option on the

menu to remove the subfield from the record.

Oops! = Undoing your last action

) Or, another method is to put your cursor in
— | the subfield and click the Delete Subfield
button on the toolbar.

K

B El7sp

Bl

Eloacm.
520] al AddSublields... = ; oot
ﬂli%
ﬂlig

&l Move Up
o2 | HEEDEE

bl Hep

Use the Undo button to reverse the last action you performed in the Cataloger. Since the last
thing you did in this tutorial was delete a subfield, you will “undelete” the subfield so that it is

back in the record.

Click the Undo button on the toolbar. The 300 ¢ subfield should now be back in your record.

Changing fields and subfields

If some of the information in your record is in the wrong field or subfield, it's easy to change the
incorrect field or subfield into the correct one. In the last tutorial, you entered the genre Poetry in the
650 x (General subdivision) subfield.

The correct subfield for this information is 650 v (Form
subdivision). In this exercise you'll change the 650 x into a
650 v so that your information is in the right place.

1. Click the 650 x subfield code button.

2. In the menu, click Change.

Gelect the sublield to change to
' Fewerchoices 1 More choices

For
Fiskk 1550 (Subject Added Entiy - Topical Tem)
Subliekt: $x (General subdivision)

o]

Concel | Hsbj
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dialog box select
Sv (Form subdivision),
or type the letter v in the

3. From the Change Subfield

100] & Reckonwith, Amanda
]|

245 8] The wee book of muskrats
L]

8] by Amanda Reckonwith ; illustrations by James DuPré .
1250] 8] 2nd ed.
1280 &) Little Rock, Ark

1] Pennypouch Press

1931
1300|875 p :

Bl

El24cm
181 50 short poems about muskrats
1650] 18] Muskrats

¥ Poetry .
650] a|

]|

box, and click OK.You should now see a v instead of an x in the

subject field.
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Displaying Help for a field

If the Tips and Examples panels don't give enough information about a particular field or subfield,
use the Cataloger's Reference to find out more about any of the fields you see in Cataloger.

The Cataloger's Reference provides in-depth information about each MARC field and subfield
right on your screen. In this exercise you'll display the Cataloger's Reference for the

100 (Main Entry: Personal Name) field.

Open Cataloger's Reference

Fe Edt Bookmak Opfions Help

1. Click the 100 field tag button and select Help from LT R e R T
. ’ W Conterts | &, x| # Search| Main Entry: Personal Name (100}
the menu to bring up the Cataloger's Reference CEEEEE ||| sesics | s | cnes | s
- . . |E] New features - N B B —
topic for this field. There are four subheadings & @ Inpoieg and g e oo e B S
. . - . =@ Working with Record Lists the main entry is the name by which the author is
below the main heading: Basics, Indicators, [3-Junyitonind T LT e
N - determine the form of the name to use by looking at the
Subfields, and Examples. R s page ofthe ke you are cataloging.
. L. . x4 Managing User Names Related topics  iond =l
The Basics topic is displayed at the moment, so the 2 o "o -cenecaoial SIS
“Basics” subheading appears in black. Click on the §E%_fm T o
other subheadings to switch to the corresponding ) -
- il Din e
topics. -
Notice that the Basics topic also provides a link to general information |, EEE—

about main entries.

Spell Check \zl

In the last exercise in this tutorial, you'll check the spelling of your record, learn how to start Spell
Check and correct misspelled words. If you're already familiar with Spell Check you can skip this

exercise.

1. First, make a record with some spelling errors in it. Under
Record, New Record, select the Book template.

2. To make it easy to follow the tutorial, fill in the subfields as
shown in this example.

You'll have to add the 490 (Series Statement/Added Entry)
field to get your record to look like this one. See “Adding
Fields and Subfields"” if you need help.

Start Spell Check
Select Check Spelling from the toolbar.

& cataloger - [Rast of Eden] - ‘@
g

X

[\ File Edt View Record Field Subfisld Template window Help - &

100| af Bteinbeck, John
4119021968

245| 2| Rast of Eden
|

jj John Steinbeck
250 of
280 a| New Yark
b Pengguin
=] 1992
300 & xxx, B2 pages
L
_CJ 20 cm
490 a| Penguin twentieth-certury classics

520 ol

Spell Check starts with the first field in the record. Any unrecognized words appear in a dialog box,
highlighted in red. In this case, the red word is Steinbeck, John. As you've probably already
experienced with Spell Check, it sometimes stops on a word that's spelled correctly because that
word isn't in the spelling dictionary. This is especially likely to happen with proper names.
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Note: You may also be wondering why the program seems
to think that Steinbeck, John is one word, when it's obviously

two. Spell Check is currently set to treat personal name
fields as whole words. There are many options available to

determine how your Spell Check works. To find out more, click
Options. Options aren't covered in this tutorial, but you can get

more information from the Help button.

Ignore a word for the entire record

Changes made with the spefing checker cannot be undone.

gwe | g | add | e

i EEe

Closs Heb

Because the name is spelled correctly, you can ignore it and move on. Author's names often appear
in the record more than once. By selecting Ignore All, you can avoid multiple stops within the record.

Steinbeck, John will now be ignored for this record.

Type in a correction
This word really is spelled wrong. You'll need to correct it.

When none of the suggested words shown is the one you want

you must type in the correction:

1. Click at the beginning of the red word.

2. Delete the R and type an E in its place.

3. Click Change to continue the spell check.

Choose an alternate word
It stops on the word Pengguin next.

Under suggestions, click the word Penguin and then click
Change. Spell Check replaces the misspelled word with the
alternate word you selected, and continues checking.

Ignore a word

The next unrecognized word is the Roman numeral in the
Physical Description field. This word is correct, so don't
change it. Instead, just click Ignore.

Add a word to your user dictionary

Check Spelling E3

$245a - Not in dictianary:

Rast of Eden

looe | lonaeAl | Ak | foct | etens. |

Changs Change Al

I Cataloger - [East of Eden] ._@E‘
M File Edit View Rerord Feld Subfield Template Window Help - & %
00| a] teinback, John

_d]1902-1968
ﬁjj East of Eden

|

_c|.John Steinbeck
50| a]
260 _a] Mew York

ﬂ Penguin
=l 1992

300 ] xxx, BOZ2 pages
&

ﬂZU cm

430 al Penguin twentieth-century classics
|

520 al

Next up is the word twentieth-century. No spelling error here - the dictionary simply doesn't
recognize it. Click Add to add this word to your user dictionary. After you have gone through the

whole record, you see the record window again, with the correct spelling.

When you're finished with this exercise, close Cataloger and return to the main window.
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Review & practice

Here are some suggestions for practicing on your own:
* Practice adding, removing, and changing fields.
* Think about what additional fields you might like to include in the standard templates.

* Try out some of the other commands on the menu that appears when you click a field tag
or subfield code (Duplicate, Move Up, Move Down).

e Open the Cataloger's Reference for some other fields and read more about them.

Go to the next tutorial

If you'd like to jump right in to the next tutorial, stay where you are in the main window. You're all set
to begin the next tutorial.
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Section 4 - Building Your Own Templates

This tutorial shows you how to make your cataloging work faster and more efficient by building your

own custom templates.

In this tutorial you will learn how to:

e Import records

e Create a new custom template.
e Create a custom template from an existing record.

e Export custom templates.
e Delete custom templates.
e Import custom templates.

Import records

The first step in working with this tutorial is to import records into MARC Magician.

Import the tutorial records
1. Open MARC Magician.
2. Select File and then Import.

3. In the Import box, click the down-arrow to the right
of the Look in box, and select C:. In the area
underneath the Look in box, double-click the
Program Files folder, double-click the MARC
Magician folder, and then Tutorial Records.mrc.

4. Click Import. When the import is done, a summary
box displays the number of records imported and
a count of the automatic cleanups completed.

What are custom templates?

Import E”gl
Laak jn: | ) MARC Magician ﬂ & & B

=] tabby hid

@tabby.ttm

[Z] TrainRecd.mrc

[Z] Tutarial Recards.mre

ZWorking with Card and Label Magician. pdf

4 *
Files of type: ‘AII Files [*) j Cancel

Help

Batch name: ‘Batch 20

Add records to list: |Master List Only j

Custom templates are cataloging templates that you design yourself. MARC Magician standard
templates are sufficient for most basic cataloging, but you may find that making your own
templates saves you time and reduces cataloging errors. Here are some more reasons to make

your own templates:

e You want to include specific fields or subfields.

e You want to weed out fields or subfields that you don't use.

e You want to have text already entered in subfields.
e You want to have control fields already set.

Important: if all you want to do is include fields that don't appear by default in the
standard templates (such as ISBN and Note fields), you don't need a custom template.
Instead, use the Add Fields to Standard Templates option on the Template menu.
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Creating custom templates

For this tutorial, imagine you have to catalog a box of over fifty short educational videos for high
school students produced by a company called VideoMaven. The videocassettes have many
characteristics in common: they were all produced and distributed by the same company, and they
all have the same playing time as well as other physical characteristics.

In the template you create, you'll fill in the subfields that are the same for all of the videos.
You'll also weed out some fields and subfields that you don't use, add some that you do, and

set the control fields correctly.

Create a new template
1. On the Template menu, click New Template.

When you create a new template, you have to select a
template to base it on, just as you do when you create
new records.

2. Select Videorecording - VHS or Beta.

3. Under New template name, type VideoMaven, and then
click OK.

The new template appears in the Cataloger. The bright blue
background on your screen indicates that you're working on a
template instead of a record. You can now edit the template the
same way you edit records.

Enter standard text

The next step is to enter the standard text that will be the same for
all of the video records.

The first field in this template is the 028 (Publisher
Number) field. Subfield b will be the same for all of the records,
so you should fill this in now.

In 028 b, type VideoMaven.
Next fill in 260 (Publication, Distribution, Etc.) field.

Select the template you want to base your new template on:

[ Sound recording - cassette -
[ Sound recording - compact disc

[ Sound recording - other

[ Sound recording - record

O Thiee-ck J item - reakia, , game, others

[ Videorecording - other

[ Videorecording - VHS of Beta

[0 Videorecording - videodisc —
New template name:

[VideoMaver|

[0k ]| come | Hep |

Al *videomaven =lalx=]
20| 5| =
23] o

|
_245] o

M [vid ding] .

L]

|

1|
260 s

|

i
200 o

|

|

|
528 a
50| s

B -
650 o

|
0l | =l

In 260 a, type Swarthmore, Pa. Remember to type the period after the state abbreviation!

In 260 b, type VideoMaven.

The videos were not all published in the same year, so leave the 260 ¢ (Date of publication,

distribution, etc.) subfield blank.

The next field with the same information in all records is the 300 (Physical Description) field.
All the videos are 35 minutes long, so in 300 a, type 1 videocassette (35 min.).

All videos have both sound and color. In 300 b, enter sound, color

All have the standard measurement for videocassettes. In 300 c, type 1/2 in.
The last field you'll fill in for this template is the 538 (System Details) field. In 538 a, enter VHS.
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Your template should now look like this:

aTemplnle: *videomaven ~lo|x
Ei 1 Delete a subfield
T You don't need the 300 e (Accompanying material) subfield
= for this template, so you can delete it now.
| .
0 B Swatror. o 1. Click the 300 e subfield code button.
ﬂl%1-mdencassette-[35-m|n] 3 2. CIiCk DEIete.
gvz:;m :
jj Save and close the template
i ~ The Close button is located in the top right corner of the
_.j o template window. When the dialog box appears, asking if

you want to save your template, click Yes.

Your template is now saved. The next time you create a new record, your template will be listed
along with the others in the Select Template dialog box.

[Select Template ____________H|
Create a new record 5;““""'*’”“"“"*
VideoMaven -
To make sure that you've created a working template, start a B’é‘!:i.mmsm. :1
new record based on the template you just made. che. fle - CD-AOM
Computer fle - diskette
1. Under Record, select New Record. Your new template BE‘.’:.:'" e - oher
should appear at the top of the list in the Select Template 0 K
box. Don't create a new record now. Now you know where L =
to find your custom templates.
2. Click Cancel to close the dialog box. [ox ]_comet | e |

Creating Templates from Existing Records
In this exercise, you'll learn how to create a custom template based on an existing record.

The scenario: You have to catalog a dozen books from the Nancy Drew series by Carolyn Keene that
were recently published in large print. After cataloging one book, you realize that the records for

the other books will be almost identical, except for the title, number of pages, summary note, and a
subject heading or two.

Open the record you want to use for the template

1. Switch to the main window by clicking the MARC Magician button on the Windows taskbar
(usually at the very bottom of your screen, next to the Start button).

2. Double-click the record titled Deadly intent, by Carolyn Keene. Return to Cataloger,
where the record you selected is now displayed in a new window:

4 start| | A MARC Magician - ... | A Cataloger -
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Create a template from the record

1. On the Record menu, click Create Template from Record.

2. When the Save Template dialog box appears, type Nancy
Drew, and then click OK. Your new template appears in the
Cataloger. Apart from the light blue background, it should
look just like the record on which it was based.

Delete subfield text

Save Template | x|

Hew template name:

INanq,| D

aK I Cancel | Help |

Next, remove some text from the template, leaving only the information that is the same for all of

the books in the series.

1. Delete the ISBN text from the 020 field. Each
book has a different ISBN, of course, so we
don't want to have this information in the
template.

2. Delete Deadly intent from the 245 a subfield.
Each book has a different title, so we don't
need this information either.

3. The number of pages also varies for each
book, so remove 154 from the 300 a subfield.

4. Leave pages (large print) in the template,
because that part will be the same for
all records.

5. The next text to remove is the Summary
note from the 520 a subfield.

% Deadly intent

020 0] J5 0942545230-(Ig -print) =

515950

1100 121 &) Keene «Carolyn .
Hl

12451 18] [5] Deadly-intent
B [text (large print)] /
]|

| Carolyn-Keene .
250 10 5] 1st-Grey-Castlewed .
260 1] [B] Grey-Castle-Press ,
161 1988..c1986 .
300 ] [a] 154-p +{large-print) ;
|
Bl22.cm .
4500 [0l 151 The-Mancy-Drew-files
520] ][5l Mancy's-assignment.is-to-find-a-missing-rock-star -Bent-Fenders.lead-
guitarist. .Barton-Novak -who.disappeared-suddenly-afterdelling-Nancy-he:had.
something:impoertant-to-tell-her .

B50) 0] J5] L arge-type-books .
B50)| (1] [&] Mystery-and.detective.stories .
B501] 121 18] Rock:music
B Fiction . =

6. The last thing to remove is a subject heading specific to this particular book, in this case,

Rock music and Fiction from the 650 field.
Your template now looks like this:

;% Template: *Nancy Drew
100 1_| [al Keene -Carolyn .

|
245110 3]

[l [text (large print]] /

L]

| Carolyn-Keens .
250 |l 1st:Grey-Castlered .
260] | sl Sharon..CT. -

b Gray-Castle-Press |

5] 1986,.c1986 .
2000 | 3l p -(large-print) ;

&

El2z2em .
490] 1_| 2] The:Nancy:Drew-iles [
20 8 | af
1650 0] (3] Large type-baoks .
650 1] [al Mystery-and.detective-stories .
0| 1] af

Bl << Twpethe $v (Form subdivision) here =
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Save and close the template. Remember to click
Yes in the dialog box asking if you want to save
your template. This template will be listed along
with the others in the Select Template dialog
box, when you next go to create a new record.

30



Exporting Templates

It is possible to share your templates with others who use MARC Magician, by exporting them out
of the program. When you export, the templates are saved to a file on your computer, a network
drive, or thumbdrive. Anyone can then import this file and use the templates you created.

Export templates
1. Under Template, select Export. :mp == 1
2. Next, decide where to save the template file.
In this exercise we'll save the templates to the
Desktop. In the Save in box of the Export
Templates dialog box, select Desktop.
3. In the File name box, enter a short name for the " =
template file. Note that the extension .txc is -t I e |
. Save as type: ITempIaha Flles (") j Cancel |
automatically appended to the template name - |
when you export. T— =
4. At the bottom of the Export Templates dialog box, Gl
select the check box for each template, and then
click Export.

2

A dialog box appears, confirming that the templates were exported successfully. The templates
are now saved on the Desktop.

Deleting templates

In this exercise you'll delete the two templates you just created. You'll

Solot atonplate o dete still have the copy you saved on the Desktop. Deleting these now al-
Horren lows you to import the templates from your desktop in the next exer-
cise.

1. On the Template menu, click Delete.

2. From the Delete Template dialog box, select one
of the templates, and click Delete.

[ooe ] _cme | v | 3. Now do the same for the other template.

Importing templates

In this exercise, you'll import the templates you just deleted back e rrT——————————T
into MARC Magician. | EEm = mciE-

&) drewmaven bxc|

1. Under Template, select Import.
2. In the Import Templates box, under Look in, select Desktop.
3. Click the template file, and then Import.

. - . File pame: drewmaven txe Import
The templates are now back in the MARC Magician database and e :TEWHE e - IKI
can be used to create new records. e
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Review & practice

Now you can take a break, practice some more on your own, go right on to the next tutorial, or get to
work on your own records. To take a break, click Exit on the File menu. Your work will be saved.

Here are some suggestions for practicing on your own:

. Create some more templates and practice adding and removing fields and subfields,
setting control fields, and adding text.

. Create some more templates based on existing records.
o Tryout some of the other commands on the Template menu, such as Rename and Edit.

Remember to use Help if you have questions!

Go to the next tutorial

If you'd like to jump right in to the next tutorial, stay where you are in the main window. You're all set
to begin the next tutorial. Remember that you can do most of the tutorials in any order you'd like.
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Section 5 - Working with Record Lists

In this tutorial you will learn how to:
e Import records.
e Sortrecords.
e Find specific records in the list.
e Move and resize record list columns.
e Show and hide record list columns.
e Select records.
e Delete records and restore deleted records.
e Create your own record lists.

Import records

If you haven't imported the Tutorial Records, you'll need to do so for this exercise. Instructions for
how to do this are on page 27.

Sorting records

The quickest way to sort the record list is to click the column header of the column you want to sort
by. Reverse the sort order by clicking it again.

To sort by Title click the Title column header. The records should now be sorted alphabetically by
title. Notice that the current sort order is displayed on the status bar at the bottom of the window:

[ctive List: Master List< Primary Sort: Title, ascending > 0 of 22 selected For Help, press F1 7

Note: Some records may have multiple entries in the bar code, call number, and subject
columns. For example, most records have two or more subject headings, so the Subject column
usually displays several entries for each record. For this reason, when you sort the records by
subject, records with multiple subject headings will appear more than once in the list.

Moving and resizing columns

In this lesson you'll change the look of record lists by rearranging columns and changing their size.

Move a column

Because there are too many columns to display all at once on your screen, you may want to change
the order in which the columns appear, so that the ones you use the most are always visible. You
change the column order by dragging the column headers with the mouse.
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Before: Author column before Title

A ] Author | Title | Yeal
@z Tolstoy, Leo Anna Karenina, / T... 1943
@= Dadrrenmatt, Frie... Der Besuch der alt... 15960
@2 Christie, Agatha  The body in the libr... 1988
@z
e

Bugs / [videorecor. .
Cwimlemt 1~ Call Crinlemt 1073

column After: Title column before Author column
A Title | Author | vea
@2 Anna Karenina, / T, Tolstoy, Leo 1245

@2 Der Besuch der alt... Dorrenmatt, Frie... 1960
@X The body inthe libr... Christie, Agatha 1988
@ Bugs / [videorecor. .

me “reclat Mrrkat (12 Qall 1073

1. Put the cursor on the Title column header.
2. Press the mouse button and hold it down.
3. While holding down the mouse button, drag the Title column header to the left of the

Author column header and

Resize a column

release it when the column is the size you want.

You can change the width of record list columns. For example, you may want to widen a narrow
column to show all of the text in it, or make columns narrower so more columns fit on your screen.

split line

A | Title Author

A Title | Author

@g  Anna Karenina, / T... Tolstoy, Leo

@g Der Besuch der alt... Darrenmatt, Frie. |
@z The body in the libr... Christie, Agatha
e Bhiec J Ladooraear

Before: narrower Title column

@2 Anna Karenina. / Tr. from the Russian by ... Tolstoy, Leo
@2 Der Besuch der alten Darne; - eine tragisc... Diimenmatt, Frie
@% The body inthe library / Agatha Christie. Christie, Agatha
l@re Binc luid ardinn) GOMMokracls ET

After: wider Title column

1. Put your cursor on the split line to the right of the Title column header.
2. When the cursor becomes a |, hold down the mouse button and drag the mouse to the right.
3. When the column is the size you want, release the mouse button.

Showing and hiding columns

Another way to customize lists is to hide the columns that you don't need. In this exercise you'll
hide some columns in the Master List.

1. Under List, select Show/Hide Columns. The Show/Hide dialog box shows  =t=ctemsminieaen
all the possible columns. .
2. Clear the check boxes for Bar Code, Created By, Export Date, Import Clcesetsy
Batch, Import Date, Import Repairs, Imported By, Update Date, and <
Updated By as shown in the figure. St
3. Click OK to close the dialog box and save your changes. Soi
The Master List now shows only the columns you selected. Show the e
hidden columns again by opening Show/Hide Columns again and selecting A Yo
the columns you want to see. s |
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Finding records

Use the Find command to locate a specific record in the list. This is particularly useful when you
have a lot of records in your database. In this exercise you'll find the record titled Almayer's Folly
and Other Stories by Joseph Conrad.

#"MARC Magician - Master List

Eile Edit View Record List Select User Template Iools Window Help

Find a record S0 0 MAE0 B FAR T

1. Select Find on the toolbar.
2. In the Find what box, enter Conrad.

3. To choose whether the program should find the word if it
appears anywhere in a column, or only if it appears at the
beginning, under Search Criteria, click Contains.

The Columns to Search list contains all of the columns in
the record list. This allows you to narrow the search.

4. To further limit your search criteria, you can limit the search to just the Author column, if, for
example, you only want to find books written by Conrad, but not books about Conrad. To do that,
select the Author column, and then Find Next.

The program finds the record and outlines it in the list. It also scrolls to the column in which the text
was found. Note that the record is outlined - not selected. You'll learn how to select records next.

1993 Acid rain [videorecarding] / executive producer

1001 _ T TR

1991 =

1991

1985 Find what
Conrad. Joseph

1986

1991

1991

1991 Columis toszarcht [auhor

1990

1992 Your text was found in the ‘Author' column.

1990
1988
1988

Find Previous | Find Newt_| Close |

L
WILDERNES
Large type bt
Large type bt
omp... Large type be
LAW - DISCF

1988
1938
1988

O RROORARRRRRARGRARAR

Keer
Keene, Caroly
Keer

#." MARC Magician - Master, List
File Edit “iew Record List Select User Template Tools ‘Window Help

"o |G| . |we|slo| & al4l@ v| Al sl 2

£ Master List
Author Title ‘fear | Template | Call NMumber | Bar Code

Acid rain [videorecording] / execu...
The age of ex

Alcohol & teenage drinking [video. idear..
All aboard [videorecording] © a col... [ “ideor..

Caonrad, Joseph

abuse.; Amp
Eallelara - Fallda 2

Active List: Master List Primary Sort: Title, ascending 3 of 45 selected For Help, press Fi

Selecting records

In MARC Magician, knowing how to select records is very important. Before you can perform any
operation on your records (like global editing, exporting, or printing), you have to select the records
you want. When you select a record, it appears highlighted in the record list.

Note: To remove a selection (or “deselect” records): just click somewhere else in the list.
The record you click on is selected, and all previously selected records are no longer selected.
Deselect a single record by clicking it while holding down the Ctrl key.
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Selecting a single record

Select one record in the list, which should now be highlighted. Now Select a different record. Notice
that the first record you selected is no longer highlighted.

Selecting several non-consecutive records

Next, you'll select several records that don't appear next to each other in the list.
1. Select a record.
2. Press the Ctrl key and hold it down.

3. One by one, click each additional record you want to select. (If you accidentally click a record
you don't want, click it again to deselect it.)

4. Release the Ctrl key.The records you selected should appear highlighted.

Selecting a block of consecutive records

1. To select several records that appear next to each other in the list, or a block, click on the first
record in the block.

2. Press the Shift key and hold it down. Tip: Use this keyboard shortcut as a
3. Click the last record in the block. quick way to select all records: Press

. the Ctrl key and hold it down. Press the
4. Release the Shift key. The block of records you
selected should appear highlighted. il i B elREsn i GG

Selecting all records
On the Select menu, click All Records.

Select records that contain a certain word or phrase

You can also select records using the commands on the Select menu. These commands let you
select records based on whether they fulfill certain criteria. Whenever you use these commands to
select records, any previous selection is removed. Only the records that meet the criteria you specify
are selected. In this example you'll use the Records with Certain Text command to select records
that contain a word or phrase that you specify.

r— @ 1. 0n the Select menu, click Records with Certain Text.

2. Under Fields to look in, choose whether the program should search the
whole record or only certain fields or subfields. In this example, you'll
search the whole record by clicking All.

3. Under Text to find, in the Look for box, enter Brown and Select to begin
searching. In this case, there will be only one record containing the word
- “Brown" . The status bar shows how many records are currently selected.

oooooogl
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£ MARC Magician - [Master List]
gﬁﬂe Edit View Record List Select User Template Tools Window Help

=11 ] Note: If you select the Match case

|8 o |me(ml | @ 5[40 ¥ M Bl 2]

check box, the program only searches

A..J A..l Author | Title | Yearl Template | Call Mumber | Bar Code Subject A - - -

(04 Acid rain [videorecording] / execu.. 1993 [ Videor Acid rain - Eny fOI' text that IS CapltahZEd exactly as
ars The age of exploration [videorecor . 1991 [ Videor Acculturation -

ang Alcohal & teenage drinking [video... 1991 [J Videor Alcohal.; Alcoh you entered |t. If you select the Whole
114 All aboard [videorecording] - a col... 1991 [ Videor Children’s films

@ All about animals [videorecording]... 1986 [ Videor Amphibians - words only check box, the program only
[ ] Conrad. Joseph  ALMAYER'S FOLLY AND OTHE [ Book |

ag The Alps [videorecording] - a disc . 1988 [J Videor Alps — Descrip searches for the Whole word you typed
ang Amphetamines [videorecaording] 1991 [ Videor Amphetamine ; - " "

114 Animal stories [videorecording] 1991 [ Videor Animals - Folk (For example' If you type monster the
4 Arabia [videorecording] - sand. se.. 1991 [ Videor Arabian Pening ’ u "

(04 Argentina [videorecording] - land 1990 [ Videor Argentina - De program won t ﬁnd monsters )_

ag The art of living [videorecording] /1992 [ Videor Art and religion

Brown, Marc Arthur's pet business [videorecor...

114 Keene. Carolyn  Buried secrets [text (large print}] ... 1988 [ Book | Large type boo

4 Keene. Carolyn  False moves [text {large print)] / 1988 [ Book ( Large type boo

@ "FREAKY PEOPLE MEED NOT [ Book ( Landlord and te

[ ] HIGH-ADVENTURE QUTDOOR [ Book WILDERNESS

@IX Keene. Carolyn  Murder on ice [text {large ;crlint_:] {1983 [ Book ( Large type bo_ol;|

1 +
|Acﬁve List: Master List ‘Pmnary Sort: Title, ascending ‘lafZZ selected |FarHe1p, pressEl Az

Deleting records

When you delete a record from the Master List, it goes into the Weeding Truck. The Weeding Truck
is like the Recycle Bin. You can restore a record to the Master List from the Weeding Truck as long
as you haven't emptied it. Once you empty the Weeding Truck, those records are gone permanently.

Delete a few records
1. Select a couple of records in the Master List.

2. Under Record, select Delete from All Lists. The selected
records will disappear from the Master List. They've
moved to the Weeding Truck, where they stay until you
delete them permanently by emptying the Weeding Truck.

Tip: Use this keyboard shortcut to
delete records: Select the records
you want to delete. Press the Ctrl
key and hold it down. Press Delete,
and then release the Ctrl key.

Restoring deleted records

If you decide that you want to keep the records you deleted after all, you can restore them to the
Master List.

1. Select Weeding Truck from the Windows menu. It now appears in the foreground and becomes
the active list.

2. Select Edit, Select All.

3. Under Record, click Move to Master List. The records should disappear from the Weeding
Truck and will now be in the Master List again.
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What are custom lists?

Custom lists help organize records into groups, by separating records from the Master List,
making it easier to carry out global editing tasks or export them in a single batch.

Custom lists contain a subset of the records in the Master List. Every record in a custom list is
also always in the Master List. If you edit a record in a custom list, the changes to the record are
reflected in the Master List (and any other custom lists that contain the record).

You can create as many custom lists as you wish, and, unlike the Master List and the Weeding
Truck, you can delete and rename custom lists.

Creating custom lists

There are a couple of ways to go about creating a new list. You can first create an empty list, and
then add records to it, or you can select the records you want in the list first, and then add them to a
new list. In this exercise you'll use the second method to create a list for all your video recordings.
You also get a chance to use a different command on the Select menu.

Select the records for your list P
1. Select all of the video recordings by using the Select menu, D oo .
and clicking Records that Use a Certain Template. %Eﬁlﬁ:ﬁiiiﬁasc
ound recording - other
2. Select the Videorecording - VHS or Beta template, and then e e o R
Select. All of the videocassettes should now be selected. OB o h o B 1
[ Videorecording - videodisc -
Adding the records to a new list
9 i ) [ _coee |t |
1. Under List, select Add Selected Records to List, and New.
- R e Mt g 2. In the New List dialog box, enter a name for your
e e ] list, and click OK. The videocassettes are now
, added to the new list, which appears in a separate
| AddSclected Recordstolist — #]  New_ ) € pll ecords in Master List . . . . .
cords De window inside the main window. The name of the
Deest sl e aric] | list appears on the title bar.
ﬁ&mmgﬂ;‘m ?;Eru:gg;? [ oK | cocel Help

Delete Whole List

‘What do you want to do with the records in this list?
. . g n i
Removing records from your list :‘”—‘—Mﬁm;
Select a record or two, and press Delete. The records are removed
from your list, but are still on the Master List.
DeleteList [[ Cancel |  Hep |
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Deleting your list
When you delete a list, you have to decide what to do with the records in it. You can leave them in
the Master List, or delete them from all lists and move them to the Weeding Truck.

1. Under List, click Delete Whole List.

2. In the dialog box, select Keep them in the
Master List (and other lists), and then
click Delete List. A message will ask if
you're quite, quite sure.

3. Click Delete List again and you're back in the Master List.

Review & practice

Here are some suggestions for practicing on your own:

 Practice selecting records using the mouse together with the Shift and Ctrl keys.
e Try out some of the other commands on the Select menu.
¢ Explore the other commands on the List menu.
e Create some more custom lists and practice adding and removing records.
As always, refer to Help when you have questions.

Tip: To delete records from all lists (i.e., move them to
the Weeding Truck), press the Ctrl key and hold it down.
Press the Delete key, and then release the Ctrl key.

Go to the next tutorial

If you'd like to jump right in to the next tutorial, stay where you are in the main window. You're all set
to begin the next tutorial. Remember that you can do most of the tutorials in any order you'd like.
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Section 6 - Working with Record Viewer

Record Viewer is a special window for browsing records in your database. It can also be used to
produce cards and labels (which we won't cover in this tutorial). For instructions on working with
cards and labels, see the Help Topics in MARC Magician.

In this tutorial you'll learn how to:
* Open records in the Record Viewer
* Browse through your records
¢ Set Record Viewer options
* Print records

What is Record Viewer?

The Record Viewer shows the field and subfield data as it appears in the raw MARC record,
including the field tags and subfield codes. You can have several records open in Record Viewer at
a time and quickly page from one record to the next. Record Viewer also allows you to do a quick
visual check of your records before exporting or printing them.

Record Viewer is more convenient than Cataloger for checking records because of the ability to
quickly page between records. It also allows you to have an unlimited number of records open at
one time, whereas Cataloger only allows 10 open records at a time.

Record Viewer also shows detailed information that doesn't appear anywhere else in the program,
including:

* Control field settings in “English”

* Leader and 007 and 008 control field MARC codes

* Additional materials data in “English” and MARC codes (006 and 007 control fields)

* Holdings data in “English”

* List of errors and warnings in the record (as defined by your Active Error Checking

settings)
o Import repair log (list of things that were repaired when the record was imported)

Opening Record Viewer [

1. Under Select, click All Records, to select all records in the Master List.

2. Click Record Viewer on the toolbar, to open the selected records. To see more information on your

screen at once, you may want to resize the Record Viewer. Record Viewer will remember its last
size and position, so you won't have to resize it again.
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Browse through the records

Use the row of buttons at the top of the Record Viewer to move from one record to the next. They are
only available when more than one record is open in Record Viewer.

i Record Viewer: The Paul Bowles Moroccan Music Collection 1957-1972 collected by Paul Bowle... E3
— —— Home | Previous | End I
Control fields MARC codes: j
1] 1 2 3
Toper Eiuen meserie gmos mim ||| Close a record
Leader: 03002¢pe--22003857a-4500 .
S emertiieerieTame 111111 enge Use the Close Record button to close a single record.
This button is only available when yo have more than
245 04 $a The Paul Bowles Moroccan Music Collection, agw
19671972 one record open. When you close a record, it is also
¢ collected by Paul Bowles for the Library of Congress. R
0 S L inenrd removed from the group of selected records in the
351 _ :: yozng;:;‘:t;?yo;::;?l ml_o_llle_ fqlluwm_g se.r!e's'l Manuscripts; Il. Microfilm; =l Main WindOW.
Record | Cards Ld:dsl
Pint Al Records... | Expost Al Records.. | Close Record |
Prit Aecord.. | Expotthis Record.. | Edt. | Opons. |  Dore Hep |

Setting Record Viewer Options

In this exercise you'll learn how to set the Record Viewer options to display only the information you
need. At the top of the record workspace, under the heading “Control Fields MARC Codes", notice
that the current view shows the coded leader and control fields. This is useful if you're familiar with
MARC and know how to interpret these codes. Otherwise, you may prefer to hide this information to
leave more room on the screen for the bibliographic data.

Hide control field codes S e e [ e

1. Click Options to bring up the Options dialog box, with e L
the View tab in front. These check boxes determine what s o ———
information is displayed in the Record Viewer. e~ S

2. Clear the Show control field MARC codes check box. [ E—

3. Click OK to close the box and save your settings. The i oy
control fields will no longer be displayed in the Record R Te—
Viewer. :

- - Co ] o | _w
Editing from Record Viewer

As you browse through your records, you may notice a mistake you'd like to fix. Although you can't
make changes from Record Viewer, you can open the record in Cataloger and edit it there.
To open a record in Cataloger for editing, select Edit at the bottom of the Record Viewer screen.

The current record is now displayed in the Cataloger. You can now edit text, add or remove fields
and subfields or change control field values. When you save the record and exit Cataloger, the
changes are shown right away in Record Viewer and you can continue checking records.
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Printing from Record Viewer

When you print from Record Viewer, the printout shows all the data as it appears on your screen.
You can print just the current record or all of the records currently open in Record Viewer.

1. To print the current record, click Print Record, or to print all records, click Print All.
2. From the Print dialog box, choose the printer you want to use and then OK. For this tutorial,
don't print anything now.

NOTE: You can also print singe records directly from Cataloger without opening Record Viewer
at all, by going to File, and clicking Print. The printout is identical to what you would get if you
printed from Record Viewer.

Closing Record Viewer

When you're done reviewing records, close Record Viewer by clicking Done or the Close button in the
top right corner of the window.

Review & Practice

Some suggestions for practicing on your own

* Select records and view them in Record Viewer.

* Open the Options dialog box again and change the View options to show other
information. The Help button gives more information about your options.

e Look at the Cards and Labels tabs.

Go to the next tutorial

If you'd like to jump right in to the next tutorial, stay where you are in the main window. You're all set
to begin the next tutorial. Remember that you can do most of the tutorials in any order you'd like.
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Section 7 - Active Error Checking

Every library has different standards and requirements for its MARC records. The Active Error
Checking feature helps you identify which of your records meet your standards and which still
need cleanup work. If you haven't previously imported the exercise files, you'll need to do that now.
You can find instructions for this on page 27.

In this tutorial you'll learn how to:
e Set Active Error Checking options.
e Use the Active Error Checking column in the main window.
e Use the Active Error Checking panel in Cataloger.
* View Active Error Checking details in Record Viewer.

Setting Active Error Checking options

With your Active Error Checking options, you define which issues you want to be notified about and

which issues you want to ignore. = O |
1. Click the Options button on the toolbar. [ -
Different catalogers have different standards for what they consider “conect” MARC records.
2. In the Options dialog box, select Active Error S s o ek e o s e el
- Fous things are shways export enors: a missing titke, 1oo many titles, too many main entries, and fields or
Checking. s e oo ong
. & [Basd
3. There are three levels of error checking: = PP PR ——
Basic, Texas Library Connection, and Custom. R ot doeeao s T L Cnnokin s e
- - ddﬂmaﬂmmmm;ﬂww{mdﬁwhﬂuhmﬂdﬂﬂ
For this exercise, select Custom. i o o ke, 3 st g 1 e e 355 e
Active Emmor Checking Settings: Custom c mnukammmhmhmmmm“wmn
records - whether to ignore them, issue wamings, of reat them as export emors.
Missing title statement (% always an export emor
Too marny main antrias & always an export emor
Too many title statements ' aways an expart emor
Fields or subfields tao long & slwaye an export emor
Publication mfarmation: ) :
Nomme o e (& ) - e el |
No date U espot error \ % waming J O igrore
Physical descipticn: If you are curious about Basic and Texas Library

Mo extent I emportenor T warning  ignoe . . .
Nogherprysicaletais  ( sspotenor  wammg | = goe | Connection, select one, and then click Show Settings.

Mo dimensions  empottenor  © waming \ * ignore

Conte e The Active Error Checking Settings dialog box shows all of
Place o puble. ot set ¢ emoteror (= waring \ Cmee | the possible issues that the program can flag.

Diate: ot set " esporteror | % waming " ignore:

R B p et © ewoterst \E wanmg / CTowe | For most issues, choose one of three options: export error,
Ho notes " exportenor ¢ wamin ' ignoie H H H H H H
Mo stoets - E‘gmm - vy ( # goe ) Warning, or ignore. There is no notification for issues
Ho hekdngs information ¢ wming \Eigoe /| that are set to ignore. Warnings and export errors are
Title in all upper case " warning igriore - . . . . . . .
Hor MARC ikl orsubfielde T saportemar (" warring distinguished in various ways in the main window,
o repeste s expotienor € werring ol the Cataloger, and the Record Viewer. You'll learn more
] - » || about that later in this tutorial.

Notice that some issues are always export errors. These are
serious problems that should always be corrected. How you set the other issues is up to you.

For this tutorial, make your settings as they appear above, and then click OK to return to the
Active Error Checking tab. Click OK again to close the Options dialog box and save your settings.
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The column - Active Error Checking and the main window

To see if the records meet our criteria look at the Active Error Checking column. Unless you moved
it, this is the first column of the record list. (You might see just the letter A... on the column header,
but if you resize the column you'll see the whole title.)

This column displays a yellow triangle for records with warnings and a red stop sign for records with
export errors. The column displays a green OK for records with no errors or warnings.

Sort the records by errors and warnings

1. Click on the Active Error Checking column header to put the records that have export errors
and warnings next to each other in the list.

2. Click the column header a second time to make the records with errors and warnings appear
at the top of the list.

Note: A red stop sign displays if a record has issues defined as errors.
A yellow triangle denotes warnings.

The panel - Active Error Checking and Cataloger
How to find errors with the Active Error Checking panel in Cataloger.
1. Select a record in the Master List, Freaky People Need Not Apply.

2. Click the Edit button on the toolbar to open the record you selected
in Cataloger.

Active Error Checking:

unknown place of pub [contral
fields].; upper caze title (245 $a);
no pub. place [260 $a); no pub.
name [260 $b]; no pub. date [260
$c)

3. Take a look at the Active Error Checking panel for the record. It should
look something like this:

If you don't see the Active Error Checking panel, it may be turned off. Turn it on by opening the View
menu and clicking Active Error Checking Panel.

In this example, the panel says that the place of publication control field hasn't been set, there is no
place of publication in subfield 260 a, no publisher name in 260 b, no publication date in 260 c, and
the title is in upper case. Notice that some of the text is black and some is red. The black text means
that we defined this particular omission as a warning. The red text indicates that we set an upper
case title to be shown as an export error.

4. To fix the title, move your cursor to subfield 245 a, delete the title and retype Freaky people
need not apply, this time with correct capitalization. Notice that the text in the Active Error
Checking panel disappears as you type.

5. To fix the place of publication, move the cursor to subfield 260 a and type New York. Notice
that the unknown place of publication (control field) disappears after you type the “k" in New
York. We set that field automatically when we recognize it!

6. To fix the publisher name, press the Enter key and type Hamster Dance Books in 260 b.
7. To fix the publication date, press the Enter key and type 71965 in 260 c.

8. Save the record and close Cataloger. When you return to the main window, the record you
corrected now no longer displays an export error in the Active Error Checking column.
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The details - Active Error Checking and Record Viewer

This exercise explains how to view detailed information about Active Error Checking issues in the
Record Viewer.

Select records With errors or warnings Select Records with Errors or Warnings  [E3
1. Under Select, click Records with Errors or Warnings. This command s:b:f:i:‘“::mgs

gives you several options. For this exercise select just records that ¢ Warings

have errors or warnings. ~ Ewors

2. In the Select Records with Errors or Warnings box, click Either errors (@ Eher enore o waings)
or warnings, and then Select. € Tile in all upper case

All records with errors or warnings should now be selected in the list.

Cancel | Help

—

Open the records in Record Viewer R

Click Record Viewer on the toolbar to see how Active Error Checking looks in Record Viewer.

Set Record Viewer options
1. To set the View options to show dtails about the errors

B[= - -
| |Ca] .t | et and warnings, select Options.
oo folds ARG codes: . . = The Options dialog box appears with the View tab in front
T Serian T j displaying the Record Viewer options.
R 2. For the Record Viewer to display the Active Error
0 0. sa Gkt L Sale, ) Checking details, the Show Active Error Checking errors
B and warnings check box must be selected.
I E" (EL,:' ) ! This check box may already be selected, but if not, select it
ecad [Coe ] Lot ] now, and click OK.
Pl Recods, | Eoptdfecnts | - CoeRecet] opions R
Prifeced. | Epottutos | g8 | oo | Do | v | Calakogng View | Active Eror Checking | Speling | Temolle | Import | Cad | Lebel | Advanced|
Cataloging view
[~ Show indicators ™ Show all spaces

Details about the errors and warnings for each record are at the

Record viewer

bottom of each record. For example, here's what is displayed Moo Moo
for the record titled High-adventure Outdoor Pursuits. e ((F Showicie ExorCheckingevrs  warinsr)
If you wanted to edit this record, you would open it in Cataloger .,

by clicking Edit. = Chang For..

Take a look at the Active Error Checking details for the other s

records. When you're finished, close Record Viewer by clicking o S ) Bl e S S
Done. Mﬂihsumurﬂ,hn;:midu:fﬂh] 245,82 -

Active Error Checking

[COK ]| comel |  Heo |

Warning Unknown place of publication in contral fields. Enter the city name of the
place of publication. You can enter [S.1.]if no information is available

Export error: The title in this record is all upper case (245 5a). Reenter the title in upper
and lower case

Warning Mo publisher's name (260 $b). You can enter [S.n ] if no information is
available
Warning Mo date of publication (260 5c)
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Important: While Active Error Checking is tremendously helpful in locating potential problems, it
isn't a foolproof way to determine the quality of your records. Records showing an OK may have
other problems (such as improper cataloging) that the program doesn't flag, and records that
show export errors or warnings may actually be correct.

For example, if you have Active Error Checking set to flag a missing publication date, your
serials (which usually aren't supposed to have this subfield) will show errors or warnings even
though they are actually correct.

Review & practice

IHere are some suggestions for practicing on your own:
* Play around with different Active Error Checking options.
* View errors and warnings in the Cataloger and the Record Viewer.

Go to the next tutorial

If you'd like to jump right in to the next tutorial, stay where you are in the main window. You're all set

to begin the next tutorial. Remember that you can do most of the tutorials in any order you'd like.
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Section 8 - Global Editing Basics

In this tutorial you'll see the power and flexibility of MARC Magician's many global editing features.

In this tutorial you'll learn how to:
* Import records into MARC Magician.
* Back up the database.
* Find and replace text in a group of records.
* Add a field to a group of records.
¢ Fix the capitalization of fields or subfields that are all in upper case.
* Restore the database from a backup.

Check Speliing... F@
FEind and Replace. ..

What is global editing? G T

Ldd Field...
Lidd Subfield .

Global editing means editing several records at a time. MARC Magician gives you

Chanage Field...

several global editing commands you can use to clean up your records: Changs ndicator fo Fiekd.
. Change Supfield...

It's unlikely that you'll need to use all of these commands on your own records. o

You'll probably find that you can get your global editing tasks done using justtwo — ...

or three of these. In this tutorial you'll learn how to do some basic global editing, Defee Sublields..

Delete Subject Headings...

as well as some best practices and warnings.

Backing up the database

By default, MARC Magician automatically backs up the database every time you exit the program.
When you are doing global editing, it's usually a good idea to back up the database more frequently.
In fact, you should get in the habit of backing up the database before every global edit.

Fix Capitalization...
Force Test into Subfield...
Risanangs Subfields...

In this exercise you'll back up the database so that if anything goes wrong with the global editing
you do in the next exercises, you can restore the backup.

1. Select File, Backup Database. Whenever you do a backup, this progress Cr——
dialog box appears. Depending on how many records are in your database, 100
backup can take anywhere from less than a second to several minutes. —_—

Tip: Use this keyboard shortcut to backup your database quickly: Press the
Ctrl key and hold it down. Press the B key, and then release the Ctrl key.

Finding and replacing text

In this exercise, you'll use the Find and Replace global editing command to search the subject
headings for an incorrect term and replace it with the correct one. You've discovered that some

of the records in your catalog have “Large type books" as a subject heading. According to the
subject heading authority you use, the preferred term is “Large print books." Perfectionist that you
are, you'd like to fix these records.
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Find and replace subfield text
1. Go to Select, All Records. All of the records in the Master List should now be highlighted.

2. Select Global Editing from the toolbar, and then

Find and Replace. - |
3. Under Fields to look in, choose Selected. You'll use the ;Em j
top part of this dialog box (Fields to look in) to restrict the 2 D E

search to only the subject fields. You could search all fields,
but by restricting the search you ensure that correct text in

:
'

Examples:  100a, 245, 500-5%9, 610
001-333
001003

other parts of the record won't accidentally be replaced. e e iee
4. Since you only want to find and replace text in subject fields, = =" ot suness
select the check box next to Subjects. e e

5. In the Find what box, enter Large type books.
6. In the Replace with box, enter Large print books, and then OK. | e sseie"

¥ Prompt me for each change 0K | fa-:d| Help

P = | When the program finds a record containing
- o 1o, c(:ém. . the text you specified, the Make Change dialog
s uem _ box appears, with highlighted text meeting your
e o e o caaer s i —acket criteria in the 6508a subject heading. Under
e o on el e Highlighted text will be changed to, is the phrase
40 O_ $a Large pint popular author library. intended to replace the existing text.
7. Click Change to change the text in the current
= record and continue searching. To change
T T e all the records at once, click Change All. This
Large prt books = makes the change in every record without any
= further prompting.
[Thenge | Dontthange| Pt | | Changean Cose | Hep |
Adding a field
In this exercise, you'll add a series statement field (490) to a group G
of books belonging to Carolyn Keene's series The Nancy Drew files. o i
1. First select the all records with Keene, Carolyn as a main entry, %é%m :'
by going to Select, Records with Certain Text. @ Des
2. Under Fields to look in, click Selected. Fﬁlﬁaﬂm =
3. Click the Main Entries check box. =
4. In the Look for box, enter Keene, Carolyn, and click Select. [ ==
All of the Nancy Drew books should now be selected. -
[
[T Match case

Select I Cancel Help
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Adding the field
Next you'll add a 490 (Series Statement/Added Entry -- Title) field to the selected records.

1. Select Global Editing from the toolbar, and then Add Field. |
The global editing dialog boxes always “remember” the last  Senct ot —
settings used, so if the Add Field command was used before, 7 Ve B
the dialog box on your screen will look different. £

2. Click Select to bring up the Select Field dialog box. Like some

of the other dialog boxes in this tutorial, this one allows you

to choose the field in one of two ways: select from the list, e s ek =l
or enter the field tag directly in the box. You know the MARC © e
tag of the field you want to add, so type it in the box rather fews 8

than selecting from the tree.

o] oo | b |

3. Click Select from text box, type 490 in the box, and then OK.
In the Add Field dialog box the Subfields area now has a white background, and the Add button
is no longer dimmed. Use this button to choose the subfield (and text) to put into the field.
4. Click Add.
5. Select the $a (Title) S— —
subfield. e - g
——| 6. Under Text for S
o7 | e The Nancy Drew files] = | Get Test..
o e subfield, type The —
Nancy Drew files, -
Sde and then click OK.

i 1007038 sl | You've made all the settings you need, so click OK
10  _ $a 87037275 ; ..
20 T $a 0942545419 (ig. print) to begin global editing.
$c $9.50
2 _ %z 03425452 (i bdg - lg i) 7. When the Make Change dialog box appears, the
%5 _ $9 (DLC) 87037275 top shows the record as it is now, and the bottom
40 $a DLC .
- sc 0L part shows the change that will be made.
d DL
2 = b e 8. Click Change to add the field in the current
. S Buiges =l record and continue searching. Each time the
S — program finds the specified text, the Make
55 (TWe) vl be 5ot "The Nancy Diew fies” =| Change dialog box reappears.
=1 9. Review a few more changes to make sure the
DortChge|  Pit | Chaogest | Cie | Wb | command is working as intended, and then
select Change All to change the rest of the

selected records.

When the program is finished editing, the Completed Add Field dialog box tells you how many
changes were made in the selected records. Click OK to close this dialog box.
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Fixing Capitalization

In this exercise, you'll use the Fix Capitalization command. Using this command isn't perfect, but

it does allow you to minimize the number of corrections you have to do by hand. You've discovered
that some of your records were typed in all upper case letters. You want to contribute these records
to a union database, but they don't accept records with improper capitalization.

Select records

1. Under Select, click Records with Errors or Warnings, to select all the
records you want to edit. C Warings

2. Choose Title in all upper case, and then Select.

Add selected records to list

Because you will have to correct some capitalization by hand after you do
the global edit, it's a good idea to put these records into a list so you can keep better track of them.

1. Under List, select Add Selected Records to List, and then New.

2. In the New List dialog box, give your list a name, and then click OK. Your new list contains just
the upper case records.

Fix capitalization
Now you are ready to do the global edit. =
1. Under Select, click All Records.
2. Select Global Editing, and then Fix Capitalization. The Fix Capitalization dialog box defines

precisely which fields the program should fix. In this example, just fix the basic fields.

3. Click Fix basic fields (all except numbers, holdings, local and custom, fields). Near the
bottom of the dialog box, there is a check box labeled Check only subfields that are in all upper
case. Make sure this check box is selected. (You don't want to fix anything that isn't broke.)

4. Click OK to start the edit. Notice in the Make Change dialog box that the program often
suggests the correct capitalization - but not always.

In this example, it is most efficient to allow the T ——
program to fix all of the capitalization, and then e o e il e i)
visually check the records in Record Viewer. You can ?ﬁﬂtTfo“ -
correct the remaining mistakes by hand. ot
5. Click Change All to make the change in all of the S

s Clea Selected

selected records, without further prompting.

F Check on subliekis that re in ol upper cate

‘Waming You cant "Undo'' to
cancel changes made here.

5 Prompt me for each change 0K | cemeel | Hep |
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Review changes in Record Viewer
To review the changes in Record Viewer. @\
1. Select Record Viewer on the toolbar.

2. If you see any errors that need to be fixed, click Edit to open Cataloger for the current record.
When you're finished, exit Cataloger to return to Record Viewer and continue scanning records.

3. When you're finished checking the records, close Record Viewer.

Delete the list

You don't need to keep these records separate from the rest of the records in the Master List
anymore, so you can delete the custom list you created.

1. Under List, click Delete Whole List. When the Delete Whole List dialog box appears remember
that the edited records should remain in the Master List. You only want to delete your
temporary list.

2. Click Keep them in the Master List (and other lists), and then click Delete List twice.

Restoring the database

In this last exercise you'll restore the database from a backup. When you do this, you'll reverse all of
the changes you made in this tutorial.

1. Go to File, Restore Database. Notice that the Restore
Database dialog box shows a number of backup files. Restore o
By default, a backup file is created automatically every time | = ] - ons
you exit the program. Choose the one you created at the
beginning of this tutorial. The name of the backup file
shows the date and time it was created, with the following

@ MARC Magician Backup 2004 07 15 092225.mmd

syntax:

“MARC Magician Backup" followed by the 4-digit year, :Mw :M_mc T | ;.:: |

2-digit month, 2-digit day, and 6-digit time (hour, minute, - |
2

and second, using a 24-hour clock).

2. Select the most recent backup, (it should be at the bottom of the list) and click Open. Your
database is now restored to the way it was at the beginning of this tutorial.
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Caveat Editor!

Global editing is powerful stuff. You can fix a lot of errors in a very short time, but you can also do
a lot of damage. Global editing can't be reversed with the Undo command, so don't use global
editing on your own records until you fully understand how it works.
Here are some ways to “hedge your bets:"
* Practice the command a few times on the practice records before working with your own
records.
e Try the command on a single record first.

o Always review at least the first four or five changes in the Make Change dialog box before
changing all of the selected records.

* Before you do a global editing procedure, click on File, Backup Database. If something
goes wrong, use Restore Database to go restore the records to what they were.

Review & practice

Here are some suggestions for practicing on your own
* Practice the global editing commands you learned in this tutorial.
e Try out some different global editing commands.
e Look up importing and exporting in Help.

Go to the next tutorial

If you'd like to jump right in to the next tutorial, stay where you are in the main window. You're all set
to begin the next tutorial. Remember that you can do most of the tutorials in any order you'd like.

Mitinet Library Services - Getting Started with MARC Magician Professional 52



Section 9 - Advanced Global Editing

This tutorial covers two new global editing commands: Change Field and Force Text into Subfield.
You'll also be using some advanced features: “only when" to make a change only when a certain
condition is present, and “get text" to copy text from elsewhere in the record. If you didn’t import
records in the previous tutorial, follow the instructions on page 27 to import the practice records
into your database.

In this tutorial you'll learn how to:
* Globally change a field.
e Use the “"only when" feature to make changes only when a certain condition is present.
e Globally “force text" into a subfield.
e Use the “get text" feature to copy text from another part of the record.

Changing a field & “only when"

In this exercise, you'll use the Change Field global editing command to fix a number of records all
with the same error by using the advanced “only when" feature to ensure that only the records you
want to change are changed.

The scenario: Some of your video records have the words “VHS format” in the 500 (General Note)
field. The proper field for this information is 538 (System Details). Because these records also
contain other 500 fields that are correct, you can't change all of the 500's to 538's - you'll have to
see to it that only the incorrect fields get changed.

Select records with certain text
The first thing to do is select all the records that have“VHS format” in the 500 (General Note) field.
1. Go to Select, Records with Certain Text.

2. You may notice that parts of the Select Records with Certain Salect Records with Cortain Text ]
Text dialog box are filled in already, because we've used Fren
this function in previous tutorials. Under Fields to look in, = M‘”D
click Clear Selected to clear the previous setting. e e =

- - . [ 502 (M ation)

3. Click the plus sign next to the Notes category to expand it, Dl i Stk i)
and then select 500 (Note: General), or type 500 in the o —
Fields to search bOX. Examples: éE?ﬁiﬁ,EDD-ESB,Em

4. Under Text to find, in the Look for box, delete any existing e o]
text and type VHS format. |

5. Click Select. |

™ Match case

H H ¥ whole words only Insert Wikdeard
The records should now be selected in the Master List. Look at the

status bar at the bottom of the main window to see how many are
selected.

Select Corcel | Hep |
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Add selected records to list

Next add the selected records to a custom list. This step isn't required but creating a separate list
helps to keep track of the records being changed following the global edit.

1. Go to List, Add Selected Records to List, and then New.

2. In the New List dialog box, name your list, and then click OK. The new list should contain the
twelve records with “VHS format” in the 500 field.

Change field

Now you're ready to do the global edit. ﬁ
1. Go to Select, All Records.
2. Click Global Editing from the toolbar, and then Change Field.
3. Under Change Field, click Select to choose the field to change.

4. Use Select from text, and enter 500, and then OK. This
returns you to the Change Field dialog box.

5. To choose the field you want
: to change, go to Into field, Cos Seked
Waining You can "Undo” to cancel and click Select.
changes made here. . . .
F : | exa | e || 6. Inthis Select Field dialog
box, choose 538 (Note:
System Details) or type in B ot g et Lo s
538, and then OK. s
The Change Field dialog box should now look like this: el
d’:;uud] Select .. o ] _cwcd | e |
e S == | It's important to restrict the change to only certain 500
vrcd» fields by specifying the advanced “only when"criteria.
Eer A 7. To get to the “only when" option, click Advanced.
¢ e e o | oot |t | The Change Field dialog box expands to show this:
Always is displayed under Only when < Advanced
field meets these criteria. Oriy when fiekd meets these cikeia

For this example you don't always want
to change the 500 to a 538 _ you only
want to change it when it contains the words “VHS format,” so this setting must change.

8. Click Change to bring up the Only when field meets criteria dialog box.

9. Click Only when the following condition is met, choose a specific subfield in the 500 field and
specify what text it must contain in order for the field to be changed into a 538.

10. Under Condition, select $Sa (General note). Next to that, you should see the word “Contains”
displayed in the list.
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11. Enter VHS format in the box as shown. S
. . & Dnly when the following condition is met
Your Only When box should look like this: Corten
. . IulGenmlnnlel :] IEonlans :]
12. Click OK to save your settings and return to Change e g
. . . . =
Field where the new criteria should now be displayed Y v
under Advanced:
Advanced >>
<< Advanced
1tzumm'wsw' Ok | _Cowd | Hb |
13. Review your settings in the Change Field dialog box,
Company, A . . .
o B and then click OK which brings up the Make Change
T sl J dialog box, now showing the first record.
440 4 $a The Earth at risk erwironmental video series . . -
TR ot The field to be c_hanged is highlighted and at the
11 5T 5 Hos, Ko Seal: The Eaih At ok Seholrs: Michse bottom of the dialog box, you see what the new
Mann, Genievieve DeVerya, Samir Parikh, Nicole Cianci. -
520 __ %a Discusses the problem of acid rain, its causes, how it ﬁeld Wl" be_
spreade. and s devastaing efects o the enaonment g . .
The bk vlbe hangadio 14. Click Change to change the field and continue the
“5"”“""‘"’ = global edit. The Make Change dialog box appears for
- every potential change.
[ vonowee| _ P | owptt | oo | v | .
Remember to review at least three or four changes,

clicking Change each time, before using Change All to complete the global edit without
further prompting. When the global edit is done, the Completed Change Field dialog box tells
you how many changes were made.

Review changes in Record Viewer R
Verify that the global edit worked properly with a quick visual check of the records in Record Viewer.

1. All of the records in your list should still be selected,
but if not, go to Select, All Records.

2. Open Record Viewer from the toolbar. When Record

Viewer opens in a new window, check the first record. =L ST —
It should have “VHS format” in the 538 field. 6 04 5a Tho Pt Bows Misscan i Colectin,
RSN ibrary of Congress.
3. Click Next to move to the next record and quickly SR
scan the rest of the records. When you've checked o1 5 Cgecety o o o i e | M L Wi

all the revised records, close Record Viewer. e

Pint Al Records.. | ExpotAlRecords. | Close Recud |

PirtRecord. | Export this Record. | Edt |Wl Done Help

Delete the list

Once you're sure that the records have been properly edited, delete the custom list you created, re-
membering to retain the edited records in the Master List.

1. Go to List, Delete Whole List, Keep them in the Master List (and other lists). Select Delete List
twice.
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Forcing subfield text & “get text"

The Force Text into Subfield global edit helps when you have information that you've downloaded
and you want to copy into some of your records, but you don't want to have to edit each individual
record by hand. This function allows you to add the text in a variety of ways.

* |f the subfield you are forcing text into isn't in the record, it's added with the specified text.

* |f the subfield you are forcing text into is in a field that isn't in the record, the field is added
with the single subfield and the specified text.

¢ If the subfield you are forcing text into is already in the record, the existing text is removed
and replaced with the specified text.

* If there is more than one of that subfield in a single field, duplicates are removed.

For this exercise, the situation is that you've downloaded records from the internet that have the
classification number part of the call number in the 082 (Dewey Decimal Call Number) field. You
want to copy this information into the correct holdings subfield so your library automation system
can use it.

Rather than opening each record in the Cataloger and copying the call number by hand, you'll use
the Force Text into Subfield global editing command to “get” the information from the 082 field and
put it into your holdings.

Note: Force Text into Subfield is the best global editing command for adding holdings
information, because it adds the information to the existing holdings rather than adding
a new one. A new holding is only added when there are none.

Select records with an 082 field

Before you begin global editing, select only those records that have an 082 field. To do this, first
select all of the records that don't have this field, and then use the Invert Selection command to
select only the records that do.

1. Go to Select, Records with a Missing Field or Subfield. e S

2. In the Select Records with a Missing Field or Subfield dialog e

box, click Other, and then Change. £~ Prysical descpiion gtan o pages (20 2
: i i A . ™ Physical desciiption - gther physical detads (300 $b)

3. In the Other Missing Fields dialog box, click Select from text e

box, type 082 in the box, and click OK. __ | oves Do Col oo 2
4. Click OK again in the Select

Records with a Missing
= Field or Subfield dialog box. ===
The records with a missing

082 field are now selected in the Master List.

" Select from st

[ - -

5. Go to Select, Invert Selection to find only the records that
have the 082 field and put them in the Master List.

; memﬁ - Now you're ready to begin the global edit.

Examples: 245, 500. 245b. 650k

£

I 0K I Cancel Help
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Force text into subfield

1. Select Global Editing from the toolbar, and then Force Text into Subfield.

2. In the Force Text into Subfield dialog box, first e Lo S e
you need to select the holdings subfield where =
you want to copy the new information.

What you do next depends on your holdings type: — 4
3. If you use Easy Entry holdings, click the plus sign -
next to the Holdings category, and then select e At
the holdings element as follows: [ v | _cwen | b |

With this holdings type... Choose...

4. If you use Custom holdings,

Alexandria V Title Call # use Select from text box,
C Ma and then enter the holdings
Atht?na Call no. - Main field tag and subfield code
Dynix Call number you use for the call # or
Follett Catalog Plus Call number classification # in the box.
Library Pro Circ call 5. Click OK to return to the
LibraryWorld Erael] Force Text into Subfield
dialog box.

Winnebago Spectrum CIRC/CAT Local call number

The holdings element or

852 with 4 part call number Classification number subfield you selected should
852 with 1 part call number Call number now be displayed under
Subfield to force.

Get text I
This step specifies the text you want to force into the subfield . et
you just selected. In this example, the information comes from
subfield 082 a, and you'll use the “get text" feature to copy the |
text from this subfield. .

1. Put the cursor in the white box under Text to force into subfield by clicking anywhere in the box

and select Get Text. |

T oace o bl 2. In the Get Text dialog | < siionm
<<Fiel ecimal Call Number , Subfield: $a (Classification ;] - - M
o O e s s s o olick Select. —— -
H : ;:;ns gt ete
_ * st-caides-:lohon
3. In the Select Subfield dialog box, choose Select from text box, 5 N v ode
enter 082a, and click OK to return to the Get Text dialog box. : ?‘:"
- - = - + ocahors\l s (nc! tronic Location cess| Z]
4. Click OK again to return to the Force Text into Subfield dialog =

box, where you should now see this:
6. Click OK to begin global editing.
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As with other global editing commands, the Make

Change dialog box gives you the chance to review each Db e j
potential change before it is made: e 2: T;‘JSJf;So.d.ndg., e d
7. As always, check the first few changes to make sure omia an s G i, oo
everything is working properly. After reviewing three |7 — & giiﬁéﬁ?&‘.’d’.&o Productions, a diison of ibrry Video
or four records, use Change All to change the restof || =~ & o= )
the selected records, without further prompting. ool =
When the program is finished editing the records, the e |
Completed Force Text into Subfield box appears, showing =
how many changes were made. [T ]| DortCharge|  Pin | oot | Cone | Heb |

Review changes in Record Viewer

The records should still be selected in the Master List. If you like, you can review the changes in
Record Viewer as you did in the first exercise, on page 44.

Review & practice

Congratulations! You just completed the last tutorial. We hope these have been helpful.
Practice some more

Here are some suggestions for practicing on your own:

*Try some other global editing commands such as Change Control Field Value, Delete
Fields, and Change Subfield. Can you think of a scenario where these would be useful in
your library?

*Use the “only when" and “get text" features in different contexts.
As always, refer to Help when you have questions.
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